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2.  APPLICABILITY 

 

This Ethernet Manual applies to 1/8 DIN size Laureate digital panel meters, counters and timers 

with a Gen 1 LNET or LNET485 Ethernet communication board, and to Laureate Gen 1 LTE and 

LTSE Series DIN-rail Ethernet transmitters. Details are as follows: 

 LNET Ethernet board. Plugs into a host 1/8 DIN Laureate Series 2 digital panel meter, counter 

or timer. Provides an RJ45 connector for a 10/100BaseT Ethernet interface to a PC or Local 

Area Network (LAN). Before using this board with your meter, verify that the meter is a 

Laureate Series 2 meter. The meter can be ordered with a choice of displays, signal condi-

tioner boards, relay output boards, and analog output boards. For new applications, order the 

new, faster LNET1 Ethernet board (introduced in 2022). 

 LNET485 Ethernet-to-RS485 gateway board. Plugs into a host 1/8 DIN Laureate Series 2 

digital panel meter, counter or timer. Provides an RJ45 connector for a 10/100BaseT Ethernet 

interface to a PC or Local Area Network (LAN), plus an RJ11 connector to serve as a Modbus 

Master for up to 31 meters on an RS485 bus. RS485 wiring is via commercial straight-through 

6-wire data cables with RJ11 connectors (Laurel P/N CBL03). The host meter can be ordered 

with a choice of displays, signal conditioner boards, relay output boards, and analog output 

boards, and will function as a normal meter.  

 LTE Series Ethernet transmitters. These DIN-rail mounted instruments provide an RJ45 

connector for a 10/100BaseT Ethernet interface, plus a 4-20 mA, 0-20 mA or 0-10V isolated 

analog output and two 120 mA AC/DC solid state relays. The Ethernet chip is on the trans-

mitter main board. LTE transmitters accept the same signal conditioner boards as our 1/8 DIN 

size digital panel meters, counters and timers.  

 LTSE is serial input, analog output transmitter. These DIN-rail mounted serial-to-analog 

converter provide an RJ45 connector for a 10/100BaseT Ethernet interface, plus a 4-20 mA, 0-

20 mA or 0-10V isolated analog output and two 120 mA AC/DC solid state relays. The LTSE 

uses an LTE counter main board but no signal conditioner board. It responds to Modbus 

TCP/IP commands, not to streaming data, which is not supported by the Modbus protocol. 

Gen 1 Ethernet Nodes and instruments attached to an LNET485 gateway Node can be accessed 

over a LAN or a WAN using the Modbus TCP/IP protocol once the Nodes have been configured by 

our Instrument Setup (IS) software (Section 5), by our Node Manager software (Section 6), or by 

our Web Server firmware (see Section 7), which is built into each Gen 1 Node. 
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3.  ETHERNET PRIMER & DEFINITIONS 

 
An Ethernet node is an Ethernet connection point. Node (with a capital “N”) refers to our Laureate 

Ethernet nodes. These run special firmware, which allows them to be discovered and configured 

by our Instrument Setup (IS) PC software, by Node Manager (NM) PC software, or by the Node’s 

built-in Web Server software. Configuration data is stored in flash memory of the Node. 

Instrument Setup (IS) software is a free Window-based application that runs on a host PC. It can 

automatically discover all Nodes on the same Local Area Network (LAN) as the host PC, plus any 

RS485 devices connected to an LNET485 Ethernet-to-RS485 gateway board. It can rename the 

discovered Nodes and devices. It can scale the data to be displayed and output digitally, scale the 

analog output, set relay operation modes, and set setpoints for relay operation. While Laureate 1/8 

DIN panel mounted meters can also be programmed from their front panel, Laureate DIN rail 

mounted transmitters can only be programmed with IS software. The host meter of an LNET485 

Ethernet-to-RS485 gateway board can be programmed with IS software via the Ethernet link, but 

the remote meters on the RS485 bus can only be programmed from their front panel or via their 

RS485 interface using IS software. Laureate meters and transmitters require both jumper settings 

and software entries. Please refer to the instrument user manuals. 

Node Manager (NM) software is a free Windows-based application that runs on a host PC. Like IS 

software, it can automatically discover all Nodes on the same Local Area Network (LAN) as the 

host PC, plus any RS485 devices connected to an LNET485 Ethernet-to-RS485 converter board. 

Only Node Manager software can be used to assign static IP addresses, change port numbers, 

change TCP connection timeout, set up emails or text message to be sent periodically or upon 

alarm, set up time zones for time stamped readings, and update Node firmware, as described in 

this manual. Once the configuration data has been stored in flash memory of all Nodes, Node 

Manager software can be closed. Unlike IS software, Node Manager software cannot be used to 

scale the display of the host meter, scale the analog output, set relay operation modes, or set 

setpoints for relay operation.    

Web Server capability is built into each Node’s firmware to allow the Node to perform the same 

functions as Node Manager software except upgrading the Node’s firmware. A PC with a web 

browser is required. Once a Node is attached to a LAN, the router that controls the LAN will assign 

a unique IP address to the Node (such as 192.168.0.19). Entering that IP address as a URL into 

the browser will open the website and discover all other Nodes on the LAN. 

A MAC address is an identifier assigned to each Node at our factory for permanent identification. 

That address is 6 bytes long and is unique in the world. 

An IP address (e.g., 192.168.0.19) is used to address Ethernet nodes on a LAN or WAN. An IP 

address can be Static and Public so that it can be addressed on a WAN. An IP address can also be 

dynamic as assigned by a router or by another DHCP for addressing the same LAN. Dynamic IP 

addresses on a LAN are also called private or local IP addresses. 
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Port numbers are associated with each software application and serve as passwords for two-way 

packet transmissions. Default port numbers assigned to our Nodes are TCP port 502 for Modbus 

TCP transmissions, UDP port 63179 for UDP transmissions, and TCP port 80 for web server 

http:// transmissions. 

A router is a device that bridges two networks and forwards data packets to their destinations on a 

LAN based on their IP addresses and port number. Normally a router will use its built-in DHCP 

server capability, and network devices will use their built-in DHCP client capability, to negotiate 

private (or local) IP addresses for all devices on the LAN.  

A switch is a device that filters and forwards data packets between segments in the same network. 

DHCP server capability is built into our Nodes. When a Node fails to find a DHCP server that 

responds to its request for a private IP address, it assigns one. When several Nodes fail to receive 

a Private IP address, they mutually agree to make one of the Nodes a temporary DHCP server that 

assigns a Private IP address to each device on the network. Built-in DHCP server capability allows 

Nodes to constitute themselves into a network and be connected directly to a host computer when 

no router or dedicated DHCP server is present. The time for Nodes to decide that there is no 

dedicated DHCP server is about 25 seconds. The Nodes are intelligent enough that when another 

DHCP server comes online, the temporary DHCP server Node relinquishes its unique status and 

seamlessly becomes a client network device. 

On a Local Area Network (LAN) where the host computer is part of the network, our Nodes are 

discovered by our Instrument Setup Software or by Node Manager Software, which then lists the 

Nodes’ MAC address and private IP address. When one of the discovered Nodes is selected, all of 

the active devices on that Node are discovered, and the following information is listed for each 

device: device name, address, type, revision, signal conditioner, protocol, communication set-

tings, and reading format. 

On a Wide Area Network (WAN or Internet) where the host computer is outside of the remote 

LAN, the public IP address of the router of the remote LAN must be entered for discovery of all 

Nodes on the LAN.  

Emails and text messages with device readings and alarm status can be sent to a computer or 

to a smart phone when devices on a Node encounter an alarm condition, go on- or off-line, or at 

selected intervals. Emails containing device readings can also be sent from the Node in response 

to email requests. Each Node can be configured with an email account, recipient email addresses, 

and notification intervals. Setup of email and text messages is via Node Manager software. 

Modbus TCP is the only communication protocol supported by Laureate Nodes, not Laurel’s 

Custom ASCII protocol. Modbus TCP uses the same query-response format as Modbus RTU, but 

it includes headers and trailers to constitute Ethernet packets (or frames). When used with an 

LNET485 Ethernet-to-RS485 gateway Node, Modbus TCP is seamlessly converted by the Node to 

Modbus RTU for communication with the meters and transmitters on the RS485 bus. Note that 

the Modbus specification does not make provision for continuous data streaming, which is user 

selectable with RS232, RS485 or USB serial interfaces using the Custom ASCII protocol. 
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4.  NETWORK CONFIGURATION EXAMPLES 

 
 

 

Example 1. The host PC has a direct Ethernet cable connection to a Laureate meter or 

counter with an LNET Ethernet board or to an LTE series transmitter. This is an easy way to 

program the Laureate using Instrument Setup software or to datalog readings from the 

Laureate to a PC using XLog2 Datalogging software. 

   

 

Example 2.  The host PC is connected via an Ethernet cable to the same router or switch as 

multiple LNET or LTE Nodes so that the PC and Nodes are on the same LAN. The Nodes are 

automatically discovered by Instrument Setup software running on the PC, and their asso-

ciated Devices (or instruments) can be set up by that same software. Nodes can also be 

discovered by using the Web Server built into each Node. To do so, use a web browser and 

enter the public IP address of the router or the IP address of any Node in the network. 
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Example 3.  For connection via the Internet, the PC can be plugged into a local LAN, and 

remote instruments can be plugged into a remote LAN. When the IP address of the remote 

router is supplied, Laureate Ethernet Nodes and any Devices attached to them via an RS485 

bus are automatically discovered by our Node Manager software, Instrument Setup Soft-

ware, or XLog2 Datalogging software.  
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Example 4.  Multiple Laurel meters can be connected to the single Ethernet port of a PC if 

the first meter is equipped with an LNET485 Ethernet-to-RS485 gateway board. With this 

board, the host first meter can take measurements and also act as the gateway to up to 31 

remote meters on a half-duplex RS485 bus. The remote meters need be equipped with an 

L485 RS485 communication board and be daisy chained using 6-wire data cables (Laurel 

P/N CBL03). All meters with an RS485 interface are automatically discovered by our Instru-

ment Setup software, Node Manager software, or XLog2 Datalogging software. 
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5.  HOW TO USE INSTRUMENT SETUP (IS) PC SOFTWARE 

 

Instrument Setup (IS) Software is a tool to program Laureate digital panel meters, counters, 

timers and transmitters when communications and a PC connection are available. While digital 

panel meters can also be programmed from their front panel, IS software is required to program 

LTE and LTSE series DIN-rail mounted Ethernet transmitters. Programming includes changing the 

instrument’s protocol from the Custom ASCII protocol to the Modbus RTU protocol, scaling the 

items to be displayed or transmitted, scaling the instrument’s analog output, setting the instru-

ment’s relay operating modes, setting the setpoints of relays, and setting other parameters, like 

signal filtering. To avoid errors, ensure that only one copy of IS software is running at the same 

time. 

Programming the host instrument. IS software can use the Ethernet link from the PC to the host 

instrument of a Laureate Node to program and scale the host instrument. The Node can be the 

LNET or LNET485 Ethernet board of a Laureate meter, or the Ethernet chip inside a Laureate LTE 

or LTSE series transmitter. The communication protocol to which the host instrument is set for IS 

software to work can be Custom ASCII, Modbus RTU or Modbus ASCII. 

Programming remote instruments. IS software cannot use the Ethernet link from the PC to the 

host instrument to program remote instruments on the RS485 bus connected to an LNET485 

gateway board inside a host instrument. The remote instruments need to be programmed from 

their front panel if they are meters, or via IS software with a direct RS485 connection to the PC if 

they are LT series RS485 transmitters. The PC connection is normally via Laurel’s cables CBL02 

and CBL04, which connect the RS485 port of the LT transmitter to the USB port of the PC. 

Programming on the fly. Once Laureate instruments have been connected directly to a PC or to 

the same LAN as the PC and the communication protocol has been set to Modbus RTU/TCP, these 

can be programmed on the fly using Modbus TCP commands (same as Modbus RTU commands). 

Please see our separate Modbus Communication Manual, Analog Input and Modbus Communi-

cation Manual, Pulse Input.  

To install Instrument Setup software, first set User Account Control (UAC) of your version of 

Windows to "Never notify" so that the installation can create directories. Use Google for instruc-

tions on how to change UAC. Power down and restart your computer for the UAC change to take 

effect. Download the compressed file IS3_5_4.exe from our website onto your PC. Double-click on 

the downloaded file to unzip it into a temporary directory, such as C:\temp. Double-click on 

setup.exe and follow the prompts to install the software on your PC. Create a desktop icon. 

Following installation, you may return UAC to its previous security setting. 

To establish Ethernet communications with IS software, connect the Ethernet port of your PC 

directly to the Laureate instrument, or connect it to the same LAN as the instrument. Ensure that 

that the instrument is under power. Start IS software by clicking on Start => Programs => IS2 => 

IS2 or on the desktop shortcut that you may have established. This will open the Communications 

screen (shown below). Click on “Ethernet”, which will open the “Node Discovery” screen.  

https://www.laurels.com/downloadfiles/Modbus-Manual-DPM.pdf
https://www.laurels.com/downloadfiles/Modbus-Manual-CTR.pdf
https://www.laurels.com/downloadfiles/Modbus-Manual-CTR.pdf
https://www.laurels.com/downloadfiles/IS3_5_4.exe


10 

 

 

In the “Node Discovery” screen (shown above), all Nodes discovered by the PC will be listed. Click 

on a discovered Node, whose row will change to blue, then click on “Device Discovery”. The 

“Device Discovery” screen (shown below) will then list all Devices associated with the discovered 

Node. As a minimum, the devices will include the host meter of the LNET or LNET485 Node. They 

may also include one or multiple devices connected via RS485 to an LNET485 Node.  
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To discover remote devices on an RS485 bus interconnected by Laurel’s CBL03 data cables: 

 Jumper the LNET485 board and the remote L485 boards for half-duplex RS485. 

 Set the LNET485 host meter and remote L485 meters to Modbus RTU from the front panel 

by setting “SEr 4” to 010.  

 Enter different Modbus addresses from 1 to 247 for the host meter and remote meters 

from their front panel by entering the value under “Addr.” The factory default address is 

always 1. 

Setup of meters and transmitters requires both jumper settings and software selections. The 

instruments cannot sense the jumper settings, so this information needs to be provided either 

from the front panel of a meter or via IS software. For use with IS software: 

 The host device of an LNET or LNET485 Node, or of the Node in an LTE transmitter, can be 

programmed via IS software regardless of the entered protocol (Custom ASCII, Modbus 

RTU or Modbus ASCII). Click on the discovered host device, whose row will then turn blue. 

 Remote instruments on an RS485 bus (remote meters with an L485 communication board 

or remote LT series transmitters) cannot be programmed via IS software through an 

LNET485 board. These need to be programmed from their front panel or via IS software 

when they are connected directly to the PC via RS485. LT series transmitters can only be 

programmed by connecting them directly to a PC via RS232 or RS485.  

Click on the Main Menu button to use IS software for setup of the host meter of an LNET or 

LNET485 Node, or for setup of an LTE or LTSE Ethernet transmitter.  



12 

In the resulting DPM or Counter Main Menu screen, which is a mostly blank screen, go to “DPM” 

or “Counter,” and execute a “Get Setup” to upload the setup data from the selected Device to your 

PC. Then click on “View” and “Setup.” The resulting Setup screen will allow you to view and 

change Device setup parameters. After making changes, click on “Main Menu”. In the resulting 

DPM or Counter Main Menu screen, go to “DPM” or “Counter,” and execute a “Put Setup” to 

download the changed setup data into your selected Device. 

The Input+Display tab will display the input and output board types that the microcomputer board 

of your meter has discovered. The microcomputer board cannot read jumper positions, so enter 

input range information into this screen. Laureate instruments work in counts. Select the position 

of the decimal point, which does not affect the arithmetic in counts. Select 50 Hz or 60 Hz AC line 

frequency for noise rejection purposes. Refer to your instruments’ user manual for details. 

 

The Scaling tab relates input counts to output (or displayed) counts. Scaling can be by means of 

three methods: 1) scale and offset method, where m and b coefficients are entered for a  

y = mx + b straight line fit, 2) coordinates of 2 points method, where two (x, y) points are entered 

to define the straight line, and 3) reading coordinates of 2 points method, which fits the straight 

line to two actual readings, thereby calibrating the instrument and transducer as a system. Refer 

to your instruments’ user manual for details. 



13 

 

The Filter tab provides a choice of filtering methods. For analog inputs, the factory default is the 

equivalent of a 9.6 sec RC time constant, which provides very stable readings for constant or 

slowly changing signals. Smart adaptive filtering allows the meter to respond in about 30 msec to 

actual changes in signal by resetting filtering. The threshold to reset adaptive filtering can be set to 

Low or High. Refer to your instruments’ user manual for details. 

 



14 

The Relay Alarms tab allows you to define different action modes for operation, setpoints and 

hysteresis bands for two of four relays, as sensed. Relay setpoints are often changed on the fly 

using Modbus commands. Refer to your instruments’ user manual for details. 

 

Use the Communication tab to set the communication protocol to Modbus RTU, which uses 

the same command set as Modbus TCP/IP and is required for Ethernet operation. Do this even 

if you launched IS software with the Custom ASCII protocol. Set your baud rate to 9600, not 

higher. To enter your change into your instrument, execute a “Put Setup” from the DPM our 

counter pull-down menu of the IS software Main Menu. 
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Use the Analog Out tab to control to define the rules for your instrument’s analog output. First 

inform the software of your range as set by jumpers. Then define the reading for the bottom of the 

range, like 4 mA, and the top of the range, like 20 mA. Refer to your instruments’ user manual for 

details. 

 

Use the Lockouts tab to protect meters by disabling front panel accessible menu items. Place a 

checkmark for all menu items to be disabled. To disable all menu items, place jumper “a” on the 

power supply board. Refer to your instruments’ user manual for details. 

 



16 

Summary IS Software Operations:  

 To select a meter or transmitter, highlight its associated Node under the Node Discovery tab, 

then click on the Device Discovery tab. All discovered meters and transmitters will be listed. 

 To work on a discovered device, select it, then click on the “Main Menu” button.  

 To retrieve device setup information from the device, click on Device => Get Setup.  

 To retrieve device setup information from disk, click on File => Open Setup. 

 To view and then edit that the retrieved information, click on View => Setup.  

 To download the edited information back into the device, click on Device => Put Setup. 

 To save the edited information to disk, click on File -> Save Setup.  

Additional Instrument Setup Software Features 

The Commands pull-down menu in the menu bar at the top of the Main Menu allows execution of 

certain meter functions by using a computer mouse. With an Ethernet connection and Modbus 

RTU/TCP, these functions are limited compared to what would work with a serial RS232, RS485 

or USB connection and the Custom ASCII protocol.  

 The RESETS buttons allow Meter Reset (same as turning power on and off), Function Reset, 

Latched Alarm Reset, Peak Reset, Valley Reset, Tare Reset, and Remote Display Reset. 

  The READINGS buttons can bring up the Latest, Peak or Valley readings. 

The Readings pull-down menu offers the Display button. Clicking on it causes the meter reading 

to be displayed in the form of a large image on the computer screen. 
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6.  HOW TO SET UP NODES WITH NODE MANAGER PC SOFTWARE 

 

Node Manager (NM) software is a free Windows-based application that runs on a host PC. 

Like IS software, it can automatically discover all Nodes on the same Local Area Network 

(LAN) as the host PC, plus any RS485 devices connected to an LNET485 Ethernet-to-RS485 

converter board. Only Node Manager software can be used to assign static IP addresses, 

change port numbers, change TCP connection timeout, set up emails or text message to be 

sent periodically or upon alarm, set up time zones for time stamped readings, and update 

Node firmware, as described in this manual. Once the configuration data has been stored in 

flash memory of all Nodes, Node Manager software can be closed. Unlike IS software, Node 

Manager software cannot be used to scale the display of the host meter, scale the analog 

output, set relay operation modes, or set setpoints for relay operation. To install and use: 

1. Connect all Nodes and RS485 devices. The Nodes can be on the same LAN as the host 

computer or be connected to it via a WAN (Internet). They can also be connected directly to 

the host computer using a straight-through or cross-over Ethernet cable. Connection via a 

LAN or a straight-through cable is recommended for initial Node setup. 

2. Install Node Manager Software on the host computer. The self-extracting executable file 

NodeMgr1_1_7.exe can be downloaded from our website at no charge. To install, click on 

the .exe file and follow the prompts. The recommended installation directory is C:\Program 

Files\NodeMgr.  

3. Launch NodeMgr.exe by clicking on that file name or on the corresponding desktop icon 

that you may have created. A welcome splash screen will be displayed briefly, followed by 

the Node Discovery screen.  

4. Discover all Nodes on the network (Node Discovery tab). This is done automatically by 

Node Manager for all Nodes on a LAN upon entering the Node Discovery screen. When the 

Nodes are on a WAN (Internet), the public IP address of the router must be entered. Your 

Windows firewall settings must allow Node Manager to run, or Nodes will not be discovered. 

5. Discover all devices attached to each server Node (Device Discovery tab). This is done 

automatically and continuously for the Node’s serial settings over the selected range of 

device addresses, also for all possible combinations of protocol, parity and baud rates of 

4800, 9600 and 19200 if this option is checked.  

6. Force serial settings of discovered devices to those of the server Node (Device Discovery 

tab). Select the desired protocol, baud rate and parity for the Node, then check a box to force 

the discovered devices to the Node’s settings.  

7. Enter the time zone for each Node (Time Zone tab). This time zone plus UTC/GMT time 

obtained by the Node over the Internet will allow the Node to send correctly time-tagged 

readings and alarm notifications via email or streaming data. 

https://www.laurels.com/downloadfiles/NodeMgr1_1_7.exe
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8. Enter email addresses for each Node (E-Mail Addresses tab). These addresses will receive 

readings and alarm notifications via email messages from the Node, as programmed. 

9. Set up the email account for each Node (E-Mail Account tab). Enter the email address, 

incoming mail server and outgoing mail server so that the Node can receive and send email. 

10. Set up TCP and UDP ports (Advanced Settings tab). Enter the TCP port, a second UDP port, 

and a TCP connection timeout. Also use the Advanced Settings screen to write Node setup 

data to disk and read it from disk. 

11. Upgrade the Node’s firmware (Firmware Upgrade tab) at no charge from our website when 

a new Node firmware version is available.  

GENERAL INFORMATION 

F1 Help Key. Pressing the F1 Key for any tab or control item in the Node Manager program 

brings up comprehensive help information. To avoid executing a command item, right-click 

on the command button before pressing the F1 key.  

Get and Put Commands. The Get command reads configuration data from the Node for 

display on the host computer. The Put command writes configuration data from the host 

computer into the Node. If a Put command is not executed before exiting a Node Manager 

screen, any entered changes will be lost. A warning message will be displayed first. 

Password Protection 

A Node can operate with or without Password protection. If a Node is configured with Pass-

word protection, Node Manager allows node configuration data to be read with a Get com-

mand without a Password; however, any changes to Node configuration with a Put command 

require a valid password. For each session of Node Manager, the Password only needs to be 

entered the first time that a Put command is issued for that Node.  

If a Password is not desired, “NoPassword” appears as the Password. This allows Node con-

figuration changes to be made with only a “Continue” command from the Password screen. 

Passwords consist of 1 to 16 case-sensitive alphanumeric characters. These are encoded for 

storing in the Node and for transmission over the Ethernet. Nodes can each have a different 

Password, or the same Password can be used for all Nodes.  

A Node operating without Password protection can be changed to Password protection by 

unchecking the “Do not use Node Password protection” box and then entering the desired 

Password. If the Node is operating with Password protection, the Password can be changed 

by clicking on the “Change Password” button after first entering the current Password. The 

new Password is stored in the Node when the Continue command is clicked.   

If you have forgotten your password, call the factory number shown in the opening screen of 

Node Manager. Please have Node Manager running, the Node connected, and the Password 

screen open when you call. 
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1. CONNECTION METHOD TAB 

 

The PC-to-Node connection can be made by two methods: 

Method 1:  PC running Node Manager Software is the server, Node is the client.  

The PC sends a broadcast signal to all of the Nodes via the UDP protocol, and requests them 

to send back their IP and MAC addresses. Node Manager then lists all of responding Nodes, 

and the user chooses the one of interest. Node Manager then notifies that Node to send a 

request for a TCP connection. When the Node Manager receives it, it sends an acknowledge-

ment to the Node, and the connection is completed. This method has the advantage that the IP 

Addresses of all of the Nodes are discovered, and these do not need to be known beforehand. 

The Node Discovery tab is associated with this Connection Method. 

Method 2: Node is the server, PC running Node Manager Software is the client.  

To create a connection with a Node, the Node Manager must then know the Node's IP Address 

and TCP Port number. With this information, it sends a request for a TCP connection directly 

to the Node, which is constantly listening. The Node sends an acknowledgement, and the TCP 

connection is completed. This method does not require the use of the UDP protocol to make a 

connection. If the Node's IP Address and TCP Port are unknown, Method 1 can be used for 

Node discovery, and Method 2 can then be used. 
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2. NODE DISCOVERY TAB, LAN 

 

Nodes on a local LAN are automatically discovered under the Node Discovery tab when “LAN” 

is selected under “Select Network Type”. Nodes can be rediscovered at any time by pressing 

the “Repeat Node Discovery” button. Your Windows firewall settings must allow Node 

Manager Software to run, or Nodes will not be discovered. Check with your IT department if 

you suspect a firewall issue. 

Node discovery uses UDP Port 63179. If this port is blocked by a router, go to the “Advanced 

Settings” tab. There you can change the Local TCP port number and enter a second UDP port 

number, which will then be used for discovery in addition to 63179. 

A discovered Node must be selected before it can be configured.  To select a Node, click 

anywhere on its line. The line should then be highlighted, the “Node Connection Status” field 

should change from “Closed” to “Connected”, and the RJ45 jack of the connected Node should 

show a steady amber LED and a blinking green LED. If the selected node is already connected 

to another host computer, a new connection cannot be made, and a Node Busy message will 

be displayed. 

Shown at the bottom of the screen for each selected Node are the Node Name, Node  

MAC #, Node IP address, Node Type, and Node firmware revision. 
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3. NODE DISCOVERY TAB, WAN 

 

Nodes on a remote LAN are automatically discovered via the Internet by selecting “WAN” 

under “Select Network Type”, entering the Public IP Address of the router to which the Nodes 

are connected, and pressing on “Repeat Node Discovery”. 

Node discovery uses UDP Port 63179. If this port is blocked by the router, go to the 

“Advanced Settings” tab. There you can change enter a second UDP port number, which will 

then be used for discovery in addition to 63179. All of our other Nodes must also be changed 

to the new UDP port. 

Once discovered, individual Nodes can be selected for configuration by clicking on their line, 

as described on the previous page. Shown at the bottom of the screen for each selected Node 

are the Node Name, Node MAC #, Node IP address, Node Type, and Node firmware revision. 
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4. DEVICE DISCOVERY TAB, NOT A DEVICE SERVER NODE 

 

If the selected Node is an LNET Ethernet I/O board of a meter or an LTE Ethernet transmitter, 

only that single host meter or transmitter will be discovered as the device for that Node. If the 

selected Node is an LNET485 Ethernet-to-RS485 converter, the host meter and all RS485 

meters on the RS485 bus will be discovered as devices. The Node itself will be shown with an 

artificially assigned address of 0. The address of the discovered device will be a number from 

1-247 with the Modbus protocol. The address of the Node hosting device is always shown in 

parentheses ( ). For discovery, the Protocol under “Node’s Settings” must that of the device(s) 

to be discovered.   

To force a discovered device to the Node’s settings (protocol, baud rate, parity), check the 

box “Force discovered devices to Node’s settings,” then press “Put” to save your data in the 

device.  

To change the name of the Node or of a discovered device, select the item, enter the desired 

name, and press on “Save Name”. The new name will then be stored in the Node and will be 

included in emails and streaming data. 
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5. DEVICE DISCOVERY TAB, DEVICE SERVER NODE 

 

If the selected Node is the LNET485 Ethernet-to-serial device server option board of a meter, 

up to 31 RS485 physical devices may be discovered, including the host meter of the LNET485 

option board. Since Modbus allows addresses of 1-247, there can be unused addresses. 

Devices are being discovered continuously as the server Node tries different combinations of 

device address, protocol, baud rate, and parity. All devices with baud rates of 4800, 9600 or 

19200 can be discovered as a group, regardless of their protocol, parity or address, by 

checking the box “Discover Baud rate settings 4800 - 19200” and then pressing “Put”. Devices 

with baud rates below 4800 baud can be included in the discovery process by entering their 

serial settings under “Node’s Settings” and then pressing “Put“. The combination being tried at 

any moment for device discovery is displayed under “Discovery Trial” in the upper right of the 

screen. To speed up discovery, enter the narrowest possible address range, then press ”Put”. 

Also avoid searching at baud rates below 4800 if these are known not to apply. 

Set the same serial settings for the Node and all listed devices. Make your selections under 

“Node’s Settings” (protocol, baud rate, parity), check the box “Force discovered devices to 

Node’s settings”, then press “Put” to save your data in the Node. 
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6. TIME ZONE TAB 

 

A time stamp is included in email messages and in streaming data sent by the Node. If the 

Node has a path to the Internet (also required for email), the Node will automatically obtain 

accurate UTC/GMT time (Coordinated Universal Time or Greenwich Mean Time) from an online 

time server. The Node’s time zone or the offset from UTC/GMT time must be also supplied 

using this screen. 

To set the Node’s time zone,  select the Region as “USA/Canada” or “Other”. If the selected 

Region is “USA/Canada”, the program offers eight selectable time zones, each with the cor-

responding offset from UTC/GMT in hours. The offset is corrected for Daylight Saving time if 

that box is checked. If the selected Region is “Other”, the offset from UTC/GMT needs to be 

entered in +/- hh:mm format. If the offset time for a particular region is unknown, go to an 

Internet source such as www.timetemperature.com. To enter your selections, press “Put”. To 

read previously entered selections, press “Get”. 

Note: Only one instance of Node Manager can connect to the same Node at the same time. 

 

 

http://www.timetemperature.com/
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7. EMAIL ADDRESSES TAB 

 

Readings and alarm notifications can be emailed by the Node to a list of email addresses 

stored in the Node. 

Node’s E-Mail Address List displays email addresses stored in the Node that will be receiving 

emails from the Node. To retrieve that list from the Node, press on “Get”. To delete an address 

from the Node, highlight it, press on “Delete from List”, then press on “Put”. 

Address Book is a new window (see next page) which displays email addresses stored in the 

host computer under Node Manager. To reduce typing time, these addresses can be down-

loaded into multiple Nodes, not just the currently active Node. To remove an email address 

from Address Book, select it, then press on “Remove Selected Book Address”. To download 

email addresses from Address Book into the Node’s E-Mail Address List (shown above), select 

them, then press on “Add Selections to Node’s List”. This will close the Address Book window. 

To download the Node’s E-mail Address List to the Node, press on “Put”. 

Readings Email Notification Interval.  The readings of all devices connected to the Node are 

emailed to all email addresses in the Node at this selected time interval. Reading emails are 

disabled by entering an interval of 0 (hours or minutes).  

Alarm Email Notification Interval.  An alarm notification email can be sent to all email 

recipients each time the alarm status of a device connected to the Node changes. To reduce 

the number of emails, this interval dictates the minimum time between consecutive emails. 

Alarm emails are disabled by entering an interval of 0 (hours, minutes or seconds).  
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Alarm Dwell Time.  To reduce the number of emails, an Alarm Dwell Time is set so that an 

email message is sent only when the changed alarm state has lasted longer than this dwell 

time. If the alarm state changes during the dwell time, the dwell timer is reset.  

Alarms of Interest.  A device with alarms may have 2 or 4 alarms, some of which may not be 

of interest. To remove an alarm from Alarm Email Notifications, uncheck that alarm.  

Send Test E-mail sends a test email to all of the Nodes’ email recipients. 

Commands can be emailed to the Node with only these capitalized words in the subject line:  

LIST – Adds the sender’s email address to the email list in the Node. 

DELIST – Removes the sender’s email address from the email list in the Node. 

ACQUIRE –  Requests the last readings of all devices under this Node. 

IDENTIFY – Requests the MAC address of the Node. 

 

 

 

 

Note: Only one instance of Node Manager can connect to the same Node at the same time. 
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8. EMAIL ACCOUNT TAB 

 

A Node must have its own email account so that it can send and receive emails. 

Node's E-Mail Address. Enter a unique email address for the Node so that it can receive email, 

then press on “Put”. That address will also be shown as the sender in emails from the Node.  

Server Information (Names).  Enter names for the Incoming Mail (POP3) and Outgoing Mail 

(SMTP) servers for the Node. This information should be the same as for other email clients 

on the same network. In MS Outlook, it is found under Tools > E-mail Accounts. It should also 

be available from the network administrator or company IT department.  

Advanced User Checkboxes.  If desired, IP addresses can be entered instead of names for the 

Incoming Mail (POP3) and Outgoing Mail (SMTP) servers, and server ports can be changed 

from their default settings. Standards are Port 110 for Incoming Mail and Port 25 for Outgoing 

Mail. While Outgoing Port 25 is the standard for sending email, it is also often used for 

sending spam, so Internet Service Providers may block it. If blocked, try Port 2525 or Port 

587. 

Note: Only one instance of Node Manager can connect to the same Node at the same time. 
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9. ADVANCED SETTINGS TAB 

 

Change “Local TCP Port”  from its default of 502 if that port value is blocked by your router. 

Change “Remote Node UDP Port 2”  from its factory default of 63179 if that port value is 

blocked by your router. Node discovery will use both Node UDP Port 1 at 63179 and Node 

UDP Port 2 at the value set using this screen. 

Change “TCP Connection Timeout”  from its factory default of 30 seconds if so desired. 

Minimum timeout is 16 seconds. Enter 0 to disable timeout. If no TCP activity is detected by 

the Node during the timeout, the TCP connection is broken by the Node. 

Set “Parent Meter Interrogation”  to “Enabled” so that the Node will read data from its host 

meter or counter. Set it to “Disabled” if the host device is a remote serial display or a serial-to-

analog transmitter which does not supply data, otherwise the device will go into Reset. 

Press “Put”  to save your Advanced Setting changes in the Node. 

Press “Read Node Setup File”  to retrieve a previously saved Node setup file from disk.  

Press “Write Node Setup File”  to save your current Node setup to disk.  

Enter the Static IP Address, Gateway and Subnet Mask if not supplied by a DHCP server. 
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10.  FIRMWARE UPGRADE TAB 

 

Node firmware upgrades are available from the factory at no charge and should be installed 

into each Node when available. Upgrading the firmware will not affect data stored in the Node.  

To see if a Node needs an upgrade,  click on the Firmware Upgrade tab and note the revision 

of the currently installed firmware. Then go to our web page 

https://www.laurels.com/download-software.php and note the latest posted revision, which is 

EtherLN1_4_3.txt as of the date of this manual. If the latest posted version is newer than the 

currently installed version, download it into a computer directory of your choice. This directory 

could be C:\Program Files\NodeMgr\ which is also recommended for the Node Manager 

executable file. 

EtherLN1_4_3.txt overcomes a serious bug in the previous version EtherLN1_4_1.txt. That 

bug corrupted the registered MAC address supplied on an on-board EEPROM so that managed 

switches blocked Ethernet communications; however, the MAC address on the EEPROM 

remained unchanged. The upgraded firmware version EtherLN1_4_3.txt fixes that bug. 

To upgrade a Node, connect to the Node. Use the “Browse” button to locate your download 

directory. Select your downloaded firmware file and press on “Open”. Then press the “Start 

Firmware Upgrade” button. A red box will appear indicating “Upgrade in Process”. While this 

indication is present, do not turn off your computer or disconnect the Node, as that could 

corrupt the firmware of the Node. Once the upgrade has been completed (in about 5 seconds), 

the box will turn green. To repeat for other Nodes, connect to each Node, then repeat the 

upgrade process. 

https://www.laurels.com/download-software.php


30 

7.  HOW TO SET UP NODES WITH THEIR BUILT-IN WEB SERVER 

 
A Web Server is built into each or our Nodes and hosts a website with an IP address, which can 

be entered into the URL field of a web browser or be the destination of a web link. The Web Server 

offers the same Node discovery and setup functions as Node Manager Software, except that only 

Node Manager Software can be used for Node firmware upgrades. 

All web server pages offer online help. Simply click on the blue captions associated with each 

data entry field. 

 

How to get started:  

 Node access with browser on same LAN as the Nodes.  Once the IP address of any of our 

Nodes has been entered into your browser, all other Nodes will automatically be discovered by 

our Web Server and will be listed in the Node Discovery web page. An easy way to discover a 

first Node IP address (as well as all other Node IP addresses) is to use our Node Manager 

Software, as explained in the previous section of this manual. 

 Node access over the Internet.  If the browser is to access our Nodes on a remote LAN over 

the Internet, port forwarding must first be set up for the router that controls the remote LAN. 

The default port numbers programmed into our Nodes are UDP port 63179 for Node 

discovery, TCP port 502 for Modbus TCP, and TCP port 80 for http:// communications. If any 

of these ports are blocked by the router or a firewall, different port values can be entered into 

our Nodes, and you or your company’s IT department will then need to set up the remote 

router to forward these different port values. Once port forwarding has been set up, simply 

enter the public IP address of the remote router into your browser. This will open our Node 

Discovery web page, which lists all of our Nodes on the remote LAN. 
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1. NODE DISCOVERY Web Page 

 

 How to get here: Upon entering the public IP address of your router or the first IP address of a 

Node into your browser, this web page displays all LNET, LTE and LNET485 Nodes on the same 

LAN as the router. 

NODE NAME: A Node’s default name is “Node” followed by the Node’s unique MAC address. This 

name may be changed by the user to a more descriptive name by clicking on SETUP. 

IP ADDRESS: The Node’s IP address, which can be entered into a web browser or be the desti-

nation of a web link.  

TYPE: The Node’s type (LNET, LNET485 or LTE). LNET is an Ethernet communication board in a 

1/8 DIN instrument. LNET485 is an Ethernet-to-RS485 device server board in a 1/8 DIN 

instrument. LTE is a DIN rail mounted transmitter with an Ethernet interface. Clicking on TYPE 

brings up a FACTORY SETUP screen, which is password protected. 

FIRMWARE: The Node’s firmware version, which can be updated using Node Manager Software 

without loss of setup data. Check for the latest version, which can be downloaded from our 

website. 

SETUP: A link to the NODE SETUP web page, which allows changes to the Node’s time zone, 

name, LED status, and passwords. 

DEVICES: A link to the DEVICE DISCOVERY web page, which lists all Devices (or instruments) 

attached to the Node. With an LNET or LTE Node, this will be a single meter or transmitter. With 

an LNET485 server Node, there can be a mix of up to 31 meters and transmitters on an RS485 

bus. 

LAN: A link to the NODE DISCOVERY screen (this screen), which lists all Nodes on the LAN. 

DEVICES: A link to the DEVICE DISCOVERY screen, which lists all Devices attached to this Node. 
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2. NODE SETUP Web Page 

 

How to get here: From the top navigation bar of the selected Node. 

Background: A time stamp is included in email messages and in streaming data sent by the Node. 

If the Node has a path to the Internet (also required for email), the Node will automatically obtain 

accurate UTC/GMT time (Coordinated Universal Time or Greenwich Mean Time) from an online 

NTP time server. The Node’s time zone, daylight saving time status, and the offset from UTC/GMT 

time are supplied using this screen. 

TOP ROW: Links to DEVICE INTERFACE SETUP, EMAIL SETUP, and NETWORK SETUP screens 

for this Node. 

TIME ZONE: Select one of the six listed North American time zones, or select "Other". This data will 

be used in the time stamp included in email messages and in streaming data sent by the Node. 

Press GO to enter any change.  

DAYLIGHT SAVINGS: Indicate whether or not GMT Offset (Sec) should be automatically corrected 

for daylight saving time, which causes the local clock to be adjusted forward one hour in spring 

and backward one hour in autumn. This correction is only applied if a North American time zone 

was selected. Press GO to enter any change. 

GMT OFFSET (SEC): When the Node has a path to the Internet (as required for email), it will 

automatically obtain accurate UTC/GMT time (Coordinated Universal Time / Greenwich Mean 

Time) from an online NTP time server. If a North American time zone was selected, this field will 

automatically display the offset in seconds from UTC/GMT time. If “Other” was selected, you need 

to enter the GMT offset in seconds. To obtain the required entry, do a Google search for "world 

time zones" and convert the listed offset in hours to seconds by multiplying by 3600. Press GO to 

enter any change. 
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CHANGE NODE NAME: Used to enter a descriptive name for the Node, such as "Tank 1 Level". If a 

custom entry is not made, the assigned default name is in the format Node :D4:20:38, where the 

word "Node" is followed by the Node’s MAC address. Press GO to enter any change. 

CHANGE LED STATES: Use the pull-down selections to change the color assignments of the two 

indicator LEDs on the RJ45 jack. Changing the color assignments may be used as a temporary 

diagnostic to identify a specific Node from its light pattern. Press GO to enter any change. 

Normal operation is a follows: 

1) Following power-up, the green and amber LEDs are on 

steady until an IP address has been assigned to the Node. 

2) Once an IP address has been assigned to the Node, the 

amber LED is turned off. It will light up whenever the Node 

detects data packet activity. 

3) When the Node has made a TCP connection, the green 

LED alternates on (1 sec) and off (1 sec), while the amber 

LED is on steady.  

CHANGE PASSWORD and CONFIRM PASSWORD: If you wish to password protect the Node, 

enter the same password in these two fields. A Node can operate with or without password 

protection. If a password has been defined using this screen, this password will be required for 

any change to Node Setup, including changing the password. Passwords consist of 1 to 16 case 

sensitive alphanumeric characters, which are encoded for storing in the Node and for trans-

mission over the Ethernet. Nodes can have the same or different passwords. If you have changed 

a password, you will be given a 5-minute grace period for the change to take effect. If you have 

forgotten your password, call the Laurel and ask for Ethernet Support. Please have the Node 

connected and the Node Setup screen open when you call. 

 

 

 

 

8
7
6
5
4
3
2
1

Amber LED      

Green LED

RX -

RX +
TX  -
TX +

Ethernet Indicators 



34 

3. DEVICE INTERFACE SETUP Web Page 

 

 
 

How to get here: From the top navigation bar of the selected Node. 

Background: The Device Interface Setup screen applies to the Node whose MAC address is shown 

in the top right of the screen.  

Top row: Links to the EMAIL SETUP, NETWORK SETUP, and NODE SETUP web pages for this 

Node. 

SELECT DEVICE: Click on the selector button to display all devices that have been discovered for 

the selected Node. If the Node is an LNET Ethernet I/O board of a meter, only that host meter will 

be discovered as the device. If the Node is an LNET485 Ethernet-to-RS45 gateway Node, up to 

247 physical devices may be discovered, including the host device of the Node. There can be 

unused addresses. All device names are preceded by a number followed by an = sign. Click on a 

device name to select that device, and its name will then be shown in reverse font. You will then 

be able to make setup changes for the selected device using this screen. 

CHANGE DEVICE NAME: To rename a device, first select the device using the "Select Device" field 

to the left, then enter a new desired name. Press GO to enter any change. The new name will then 

appear under "Select Device" preceded by the device number and an = sign. For example, you may 

change the name of the first device to "Boiler 1 Pressure" to make reports more understandable. 

NODE PROTOCOL: Select Modbus for the device that has been selected under "Select Device". If 

only our devices are used, the node protocol, baud rate and parity are automatically selected in a 

plug-and-play mode as part of device discovery. Press GO to enter any change. 



35 

Use the Modbus TCP protocol to communicate over a LAN with our Nodes. This protocol is seam-

lessly converted by an LTNET485 Ethernet-to-RS485 gateway Node to Modbus RTU for communi-

cation with remote meters and transmitters on an RS485 bus. The same applies to the Custom 

ASCII protocol. 

The ? question mark protocol selection is a pass-through protocol where the Node simply passes 

through data packets to the LAN without modification in a tunneling mode. This feature should 

only be used to accommodate devices by other manufacturers and is not supported by Laurel.  

BAUD RATE: Select the baud rate for the device that has been selected under "Select Device". 

Normally select 9600 baud, which is Laurel’s default baud rate for all devices. Baud rates above 

9600 may cause errors. Baud rates much below 9600 would cause unnecessary transmission 

delays. If only our devices are used, the node protocol, baud rate and parity are automatically 

selected in a plug-and-play mode as part of device discovery. Press GO to enter any change. 

PARITY: Use the "Parity" field suitable for Modbus RTU. The factory default is “None.” Press GO to 

enter any change.  

ALARM NOTIFICATION (SEC): An alarm notification email can be sent to all email recipients each 

time the alarm status of a device connected to the Node changes. To reduce the number of emails, 

this interval in seconds dictates the minimum time between consecutive emails. Alarm emails are 

disabled by entering an interval of 0. Press GO to enter any change. 

ALARM DWELL TIME (SEC): An alarm dwell time can be set in seconds to reduce the number of 

emails sent by the Node. An email message will only be sent when the changed alarm state has 

lasted longer than the dwell time. If the alarm state changes during the dwell time, the dwell timer 

is reset. Press GO to enter any change. 

ALARM MASK: 1, 2, 3, 4: Check any boxes 1, 2, 3, 4 to receive alarm email mail notifications 

from any alarms 1, 2, 3, 4 the selected devices connected to the Node. If the device is one of our 

meters (DPM or counter), it can have 2 or 4 alarms. If it is one of our LT or LTE transmitters, it 

will have 2 solid state alarms. Not all alarms may be of interest for email notification. To remove 

an alarm from alarm email notifications, uncheck that alarm. Press GO to enter any change. 

DATA EMAIL INTERVAL (SEC): The data readings of all devices connected to the Node are emailed 

to all email addresses in the Node at this selected time interval. Data emails are disabled by 

entering an interval of 0. Press GO to enter any change. 

URL REFRESH (SEC): This is the time interval in seconds at the root pages for Node Discovery 

and Device Discovery self-refresh, thereby showing the latest Node and device discovery status. 

The default value is 16 seconds. Press GO to enter any change. 

Stop interrogating parent meter continuously? The default is NO, which means that the Node 

continuously interrogates the parent meter or transmitter for data supplied by the signal condi-

tioner board. Select YES if the node is housed in a serially driven remote display or in a serial-to-

analog transmitter, neither of which has a signal conditioner board to interrogate. Failure to select 

YES will cause a serially driven remote display or serial-to-analog transmitter to reset. 
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Force all our devices to the Node’s communication setting? All devices attached to an LNET485 

Ethernet-to-RS485 gateway Node can have their own communication settings (baud rate, parity, 

protocol, and digital address). Select YES to force all discovered devices on a device server Node 

to the Node’s communication settings, otherwise select NO. Press GO to enter any change. 
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4. EMAIL SETUP Web Page 

 
 

How to get here: From the top navigation bar of the selected Node. 

Background:  An email account can be set up for each Node. This allows the Node to send data 

readings at periodic intervals, when it encounters an alarm condition, when it goes on-or off-line, 

or in response to email requests. Commands can also be emailed to the Node with these 

capitalized words in the subject line:  

LIST – Adds the sender’s email address to the email list in the Node. 

DELIST – Removes an email address from the email list in the Node. 

ACQUIRE – Requests the last readings of all devices under this Node. 

IDENTIFY – Requests the MAC address of the Node. 

A powerful feature of our Nodes is the ability to send Alarm information to cell phones via text 

messages. This allows operators to receive alarm information within a couple of seconds 

wherever they are, even if they are in a meeting, at lunch, or outside the plant. Sending a text 

message in North America is as easy as sending an email. Specify the receiving address in the 

format below, which will vary with the cell phone carrier. “Number” is the 10-digit cell number 

without spaces or punctuation: 

 AT&T: number@txt.att.net 

 Qwest: number@qwestmp.com 

 T-Mobile: number@tmomail.net 

 Verizon: number@vtext.com 

 Sprint: number@messaging.sprintpcs.com 

 Sprint: number@pm.sprint.com 

 Virgin Mobile: number@vmobl.com 

 Nextel: number@messaging.nextel.com 

 Alltel: number@message.alltel.com 

 Metro PCS: number@mymetropcs.com 

 Powertel: number@ptel.com 

 Boost Mobile: number@myboostmobile.com 

 Suncom: number@tms.suncom.com 

 Tracfone: number@mmst5.tracfone.com 

 U.S. Cellular: number@email.uscc.net 
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Top row: Links to DEVICE INTERFACE SETUP, NETWORK SETUP, and NODE SETUP web pages. 

POP3 SERVER: The incoming mail server to be used for the Node. Enter the same name as for the 

other email clients on the same network, such as mail.mycompany.com. Press on the first GO to 

enter. 

POP3 USERNAME: The username to be supplied to retrieve incoming email. It is tied to the 

Node's specific email address and is normally supplied by the network administrator or company 

IT department. Press on the first GO to enter. 

POP3 PASSWORD: The password to be supplied to retrieve incoming email. It is tied to the 

Node's specific email address and is normally supplied by the network administrator or company 

IT department. Press on the first GO to enter. 

POP3 PORT: A number which identifies the type of incoming email port. Leave at 110, which is 

the normal number for a POP3 port. The POP3 protocol assumes that there is only one client con-

nected to the mailbox. On rare occasions, a network administrator or company's IT department 

may specify a different number. Press on the first GO to enter. 

POP3 INTERVAL (SEC): The interval in seconds at which to Node will check email. Enter 0 to 

disable email checking. The maximum interval is over 4 million seconds. Normally do not check 

email more often than every 60 seconds. Press on the first GO to enter. 

SMPT SERVER: The outgoing mail server to be used for the Node. Enter the same name as for the 

other email clients on the same network, such as mail.mycompany.com. Press on the first GO to 

enter. Press on the first GO to enter. 

SMPT EMAIL ADDRESS: The email address that will be shown as the sender of the email. A 

typical email address would be in the format user1@mycompany.com. Press on the first GO to 

enter. 

SMPT PORT: A number which identifies the type of outgoing email port. Normally leave the 

number at 25, which is the standard for sending email via SMTP. Since port is also often used for 

sending spam, Internet Service Providers may block it. If blocked, try Port 2525 or Port 587. 

Press on the first GO to enter. 

ADD NEW EMAIL ADDRESS: Write in each email address which is to receive emails from the 

Node, then press GO. Addresses should be in the format user@mycompany.com. All entered 

addresses will appear below the email entry field, each preceded by a DELETE box. 

DELETE: Check each box to the left of any previously entered recipient email address that your 

wish to delete from the Node, then press GO to execute. This will update the Email Setup screen. 

TEST EMAIL: Check the Test Email box, then press then press GO to execute. This will send a test 

email to all email recipients that have been defined using the ADD NEW EMAIL ADDRESS field to 

the left, thereby verifying email operation. 
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5. NETWORK SETUP Web Page 

 
  

How to get here: From the top navigation bar of the selected Node. 

Background:  Each Node has an IP address which is used to address the Node on a local area 

network (LAN) or on the Internet (WAN). An IP address can be static and public so that it can be 

addressed on over the Internet and have an associated domain name. It can also be a dynamic 

address assigned by a router or other DHCP server on a LAN. Such an address is also called a 

private or local IP address. Our Node-resident firmware automatically discovers the IP address of 

all Nodes on a LAN or WAN, plus any Devices on the RS485 bus connected to an Ethernet-to-

RS485 Device Server Nodes. 

Top row:  Links to DEVICE INTERFACE SETUP, EMAIL SETUP, and NODE SETUP web pages. 

REFRESH NET: Enter a checkmark and press GO to refresh the Node's IP address on command 

from the network. 

STATIC IP: Enter a static IP address for the Node if you want to be able to address the Node from 

anywhere over the Internet. An IP address is a 4-byte number (e.g., 192.168.0.57). Leave the 

entry at 0.0.0.0 if you want the IP address to be assigned dynamically by the router for the LAN on 

which the Node is located, or by the Node itself if there is no router or other DHCP server. Press 

GO to enter any change. 
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GATEWAY IP: Enter the static IP address of your LAN's gateway router if you want to be able to 

address your Nodes from anywhere over the Internet. This address is normally provided by your 

organization's IT department. Leave the entry at 0.0.0.0 if you do not want address your Nodes 

from anywhere over the Internet. Press GO to enter any change. A gateway router is a device 

which provides the entrance to a local area network (LAN). This is normally a router which assigns 

dynamic IP addresses and also serves as a firewall. A gateway can interface a first LAN to another 

LAN or to the Internet. 

SUBNET MASK: Enter the subnet mask for your LAN's gateway router if you want to be able to 

address Nodes on the LAN from anywhere over the Internet and if a subnet mask entry has been 

requested by your organization's IT department. A subnet mask is a way of telling your router 

which network addresses it can consider local and which are remote. Leave at 0.0.0.0 to disable 

the subnet mask feature. Press GO to enter any change. 

TCP TIME-OUT: Change “TCP Connection Timeout” from its factory default of 32 seconds if so 

desired. Minimum timeout is 16 seconds. Enter 0 to disable timeout. If TCP activity has not been 

detected by the Node for this timeout period, the TCP connection is broken by the Node. Press GO 

to enter any change. 

MODBUS TCP PORT: Enter the TCP port number of the Node or leave that number at 502 if you 

have no reason to change. Press GO to enter any change. The standard TCP port number for 

Modbus is 502. It is possible to use a different port number, provided that both the client and 

server can be set to use a different port number. This may not be possible, and in most cases it 

will be most convenient to just use the standard port number 502. Our Node discovery software 

uses TCP port 502 and UDP port 63179.  

HTTP PORT: Enter the HTTP port number of the Node or leave that number at 80 if you have no 

reason to change. Press GO to enter any change. By default, port 80 is used by URLs that begin 

with http:// and is the default port number for HTTP communications. Port 443 is used by URLs 

that begin with https:// . Only enter a port number other than 80 if that number has been blocked 

by the IT department and a different number has been supplied. If the port number is changed to 

anything other than 80, all web addresses that reference the Node must include that port number. 

DISCOVERY PORT: Enter a second UDP port number if required. Leave the UDP number at 63179 

if you do not require a second UDP port number. Press GO to enter any change. The TCP and UDP 

protocols specify a source and destination port number in their packet headers. A port number is 

a software construct associated with permissions for an application such as our Node discovery. 

Our Node discovery software uses TCP port 502 and UDP port 63179. If port 63179 is blocked by 

a router, this field can be used to enter a second UDP port number, which will then be used for 

Node discovery in addition to 63179. 

AUTO-DISCOVERY: This default selection permits the Node to broadcast a 70-byte self identifi-

cation message over the LAN every 15 seconds, a very light load on the network. This allows the 

Nodes to discover each other's IP Addresses, thereby greatly facilitating network setup and 

maintenance.   
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STEALTH MODE: This setting precludes the Node from broadcasting a 70-byte self-identification 

message over the LAN every 15 seconds. This setting should only be selected if such broad-

casting is not allowed by IT department policy, as it does not allow the Nodes to discover each 

other's IP Addresses. However, IP addresses can still be discovered by our PC-resident Node 

Manager software. 

NTP SERVER: Enter an NTP time server, if desired, other than www.pool.ntp.org. This is the 

default online NTP time server used to synchronize the clocks in our Nodes and also millions of 

other networked devices. It returns extremely accurate UTC/GMT time (Coordinated Universal 

Time or Greenwich Mean Time), which is then modified by our Nodes for the local time zone and 

is used to time and date stamp emailed and streamed reading data. Press GO to enter any change. 

NTP INTERVAL (SEC): Specifies how often the Node will correct its own quartz crystal clock by 

checking the NTP time server. The default interval is 86400 seconds, or one day. Press GO to 

enter any change. 
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6. DEVICE DISCOVERY Web Page 

 

How to get here: Select a specific Node on the NODE DISCOVERY PAGE and click on DEVICES or 

on NODE. 

Background: This screen displays all Devices (or instruments) discovered for the Node. If the 

Node is an LNET Ethernet board in a meter or counter or is an LTE transmitter, only a single 

Device will be shown, namely the host meter, counter or transmitter. If the Node is an LNET485 

Ethernet-to-RS485 gateway Node, there can be up to 247 Devices, namely the host meter or 

counter plus additional Devices on an RS485 bus. Hovering over any underlined item will bring up 

an informational bubble. 

NAME: The name assigned to the discovered Device using the DEVICE INTERFACE SETUP page. 

TYPE: The instrument type programmed into the Device by the factory. Choices are DPM for 

analog input (including panel instruments and transmitters), CTR for pulse input (including panel 

instruments and transmitters), and WT for meters with weighing firmware (panel instruments). 

DATA: The data transmitted by the Device. Setup of transmitted data can be by means of Instru-

ment Setup Software (panel instruments and transmitters) or front panel keys (panel mounted 

instruments). Hover for data labels. For example, hovering over “+2.001 / +2.001 / +2.001” brings 

up the bubble “Reading / Peak / Valley”. 

ALARM:  State of up to 4 alarms, where 0 indicates no alarm and 1 indicates an alarm state. If the 

Device is one of our panel instruments, it can have 2 or 4 alarms. If it is one of our LT or LTE 

transmitters, it will have 2 alarms. Setup of alarms can be by means of Instrument Setup Software 

(panel instruments and transmitters) or front panel keys (panel mounted instruments). 
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8.  TROUBLESHOOTING HINTS 

 

Inability to discover a Node may be due to a corrupted MAC address in the Node. That may be 

the case if the Node can be discovered with a direct cable connection to a PC or through an 

unmanaged switch, but not through a managed switch. Laurel Nodes shipped between June and 

October 2022 have been known to corrupt the supplied registered MAC address so that the Node 

cannot be pinged or discovered through a managed switch. The solution is to upgrade the Node’s 

firmware to EtherLN1_4_3.txt, as explained under the FIRMWARE UPGRADE TAB of this manual. 

Laurel factory support is prepared to assist you, but we can only go so far in resolving system-

level network issues. We will first ask if the Node can be pinged. If it cannot be pinged, it is not 

available on the network, and we cannot do remote troubleshooting. To do the latter, we will ask 

that TeamViewer or similar remoted desktop software be installed on a customer's PC connected 

to the customer’s network. 

Inability to install Instrument Setup (IS) software is most often due to User Account Control 

(UAC), a Windows security feature. To allow IS software installation, first set UAC of your version 

of Windows to "Never notify" so that the installation can create directories. Use Google for 

instructions on how to change UAC with your version of Windows. Power down and restart your 

computer for the UAC change to take effect. Following installation of IS software, you may return 

UAC to its previous setting. 

Inability to open the IS Software Main Menu for a discovered and highlighted Device is most 

often caused by a Windows Defender firewall, which prevents IS software executable components 

from running and results in a variety of error messages. To open the firewall of your version of 

Windows for IS software, enter “firewall” into the search field of the Windows icon in the lower left 

of your monitor. Or click on “Windows Firewall” from the Windows Control Panel. Follow the links 

and ensure that Instrument Setup and its executable .exe components are allowed. With normal IS 

installation, the executable IS files are listed in the directory C:\Program Files (x86)\IS2 and are as 

follows: 

 Ctr5T.exe 

 CtrW.exe 

 DPM5T.exe 

 DPMW.exe 

 Instrument Setup.exe 

 WT5T.EXE 

 WtW.exe 

Firewall issues can also be caused by third-party firewall and antivirus protection software like 

McAfee or Norton. Do a Google search on how to change such third-party firewall settings to 

allow our specific software to run. The IT departments of large companies often set tight firewall 

rules. If you suspect a firewall issue and work for a large company, call in an IT representative. 



44 

Inability to open the IS Software Main Menu can also be caused by the factory default choice of 

Custom ASCII protocol. That protocol works great with RS232, RS485 or USB, but not with 

Ethernet, which requires Modbus TCP/IP. Modbus RTU is seamlessly converted to Modbus 

TCP/IP and back by our Nodes.  

If your Laureate is a panel meter or counter that was set to Custom ASCII, the easiest way to 

change it to Modbus is from the front panel by setting the menu item “Ser 4” to 010.  

If your Laureate is an LTE or LTE transmitter that was set to Custom ASCII, you can change it to 

Modbus with Node Manager software or IS software. With IS software: 

1. In the “Communication” screen, select “Custom ASCII” and “Transmitter LTE, LTSE.” 

2. Press “Ethernet.”  

3. In the resulting “Node Discovery” screen, highlight your Node and press “Device Discovery.”  

4. In the resulting “Device Discovery” screen, checkmark “Force discovered devices to Node’s 

Settings,” highlight your Device, and press “Main Menu.”  

5. In the Main Menu, press “Counter” or “DPM” in the top menu bar depending on your Device, 

and press “Get Setup.”  

6. In the resulting IS software main screen, press “View” and then “Setup.”  

7. Press the “Communication” tab and verify that “Serial Protocol” is set to “Modbus RTU.” If 

not, set it to “Modbus RTU,” click on “Main Menu,” and execute a “Put” to download your 

Modbus RTU selection into your Device. 

Get and Put commands will not work as expected when multiple copies of IS software are running 

on your PC. Ensure that only one copy of IS software is active on your PC at the same time. 

As an aid to diagnostics,  the Ethernet connector for all of our Ethernet Nodes is provided by an 

RJ45 jack, where green and amber LEDs on the jack indicate network operation: 

1) Following power-up, the green and amber LEDs are on steady until an IP address has been 

assigned to the Node. 

2) Once an IP address has been assigned to the Node, the 

amber LED is turned off. It will light up whenever the Node 

detects data packet activity. 

3) When the Node has made a TCP connection, the green LED 

alternates on (1 sec) and off (1 sec), while the amber LED 

is on steady.  

Ethernet cables (CAT5 or better) can be straight-through or crossover. Our Ethernet Nodes 

automatically adapt for either. 
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